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Prefazione

Il presente manuale descrive come installare e utilizzare il software di collaborazione

SunForum™ con un sistema Sun™. È rivolto ad utenti che desiderano collaborare via

intranet e Internet con altri utenti che utilizzano sistemi UNIX® o PC tramite data

conferencing.

Organizzazione del manuale

Capitolo 1: descrive il prodotto SunForum.

Capitolo 2: descrive l’utilizzo di SunForum, incluse le funzionalità audio e video e la

lavagna di SunForum.

Capitolo 3: descrive la funzione telefono di SunForum 3.2.

Capitolo 4: descrive l’accesso gateway di SunForum.

Capitolo 5: descrive l’uso di SunForum su un sistema Sun Ray™.

Capitolo 6: fornisce informazioni tecniche sul software SunForum.
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Uso dei comandi UNIX

Questo documento non contiene informazioni dettagliate sui comandi e sulle procedure

UNIX di base, come l’arresto o l’avvio del sistema e la configurazione dei dispositivi.

Per questo tipo di informazioni, consultare i manuali seguenti:

■ Manuale di Solaris per le periferiche Sun

■ La documentazione in linea AnswerBook2™ relativa all’ambiente operativo

Solaris™ 2.x

■ Altra documentazione sul software ricevuta con il sistema.

Convenzioni tipografiche

Tipo di carattere Uso Esempi

AaBbCc123 Nomi di comandi, file e

directory; output del computer

sullo schermo.

Modificare il file .login .

Usare ls -a per visualizzare tutti i

file.

% Nuovi messaggi .

AaBbCc123 Caratteri digitati dall’utente in

contrasto con l’output del

computer sullo schermo.

% su
Password:

AaBbCc123 Titoli di manuali, termini citati

per la prima volta, parole

particolarmente importanti nel

contesto; variabili dei comandi da

sostituire con nomi o valori reali.

Leggere il Capitolo 6 del Manuale utente.

Queste opzioni sono dette classi.

È necessario essere superutente .

Per cancellare un file, digitare rm
nome_file.
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Prompt delle shell

Documentazione Sun sul Web

Il sito Web docs.sun.com sm permette di accedere in linea alla documentazione

tecnica di Sun, consultando l’archivio docs.sun.com o ricercando un titolo o un

argomento specifico in:

http://docs.sun.com

Come ordinare la documentazione Sun

Fatbrain.com, una libreria professionale on line, offre una selezione della

documentazione prodotta da Sun Microsystems Inc.

Per un elenco dei testi disponibili e per istruzioni su come ordinarli, visitare il Sun

Documentation Center in Fatbrain.com al seguente indirizzo:

http://www.fatbrain.com/documentation/sun

Shell Prompt

C shell %

C shell, superutente #

Bourne shell e Korn shell $

Bourne shell e Korn shell, superutente #
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Sun è lieta di ricevere commenti

Sun desidera migliorare la propria documentazione e gradirebbe ricevere commenti

e suggerimenti al riguardo. È possibile inviare a Sun commenti per posta elettronica

all’indirizzo seguente:

docfeedback@sun.com

Si prega di includere il numero di parte del documento (816-0865-10) nell’oggetto del

messaggio.
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CAPITOLO 1

Introduzione a SunForum

Il software SunForum 3.2 è un prodotto di data conferencing per sistemi di

elaborazione Sun. È basato sugli standard T.120 e H.323 e permette ai sistemi Sun di

comunicare in conferenza via intranet e Internet con altri prodotti T.120 e H.323.

Funzioni di SunForum

SunForum 3.2 offre le funzioni seguenti:

■ Visualizzazione e controllo delle applicazioni condivise da altri sistemi UNIX o

PC basati sul protocollo T.120.

■ Condivisione di applicazioni Solaris locali, che possono essere visualizzate e

controllate da qualsiasi partecipante alla conferenza.

■ Scambio di idee e dati usando la lavagna, la clipboard, la conversazione e le

funzioni di trasferimento file.

■ Utilizzo della comunicazione audio e video tramite il protocollo H.323.

■ Generazione di toni DTMF, in banda e fuori banda, tramite il protocollo H.245.

■ Test e risoluzione dei problemi in caso di apparecchiature Voice-over IP (VoIP) e

H.323 con specifiche ambigue.

■ Nuova interfaccia utente Telefono di SunForum (SunForum Phone).

■ Possibilità di effettuare automaticamente chiamate tramite un gateway.

■ Gatekeeper Sun.

■ Tool di configurazione per server LDAP (Lightweight Directory Access Protocol).

■ Codifica audio G.729a.
1



Guida in linea

SunForum offre una serie di informazioni consultabili in linea. La guida in linea è

accessibile dal menu Guida (Help), presente in tutte le barre dei menu di SunForum.
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CAPITOLO 2

Uso di SunForum

Nel presente capitolo verranno trattati gli argomenti seguenti:

■ “Nozioni di base su SunForum” a pagina 3

■ “Uso degli elenchi” a pagina 9

■ “Uso del software SunForum” a pagina 12

■ “Uso di video e audio in SunForum” a pagina 17

■ “Uso della lavagna di SunForum” a pagina 25.

Nozioni di base su SunForum

▼ Avviare il software SunForum

● Dopo avere installato i pacchetti del software SunForum 3.2, digitare il comando
seguente al prompt del sistema:

Nota – Se la directory di SunForum non è impostata nel proprio percorso di ricerca,

inserire il percorso corretto (ad esempio, /opt/SUNWdat/bin/sunforum ).

Viene visualizzato il gestore di conferenze di SunForum. Al primo avvio di

SunForum, tuttavia, si apre la finestra Informazioni personali.

% sunforum
3



FIGURA 2-1 Finestra Informazioni personali

● Nella finestra Informazioni personali, inserire il proprio nome e indirizzo di posta
elettronica.

Nota – È necessario inserire il proprio nome e indirizzo di posta elettronica. Senza

queste informazioni di base non sarà possibile collaborare con gli altri utenti.

All'avvio successivo di SunForum, la finestra Informazioni personali non verrà più

visualizzata automaticamente. Tuttavia, le informazioni di questa finestra potranno

essere modificate in qualunque momento scegliendo Chiama ➤ Modifica
informazioni personali.

Dopo avere completato la compilazione della finestra Informazioni personali, verrà

visualizzata la finestra della procedura guidata di configurazione per audio/video.
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Al termine, come finestra attiva, verrà visualizzato il gestore di conferenze di

SunForum.

FIGURA 2-2 Gestore di conferenze di SunForum 3.2
Uso di SunForum 5



I menu di SunForum

La barra dei menu di SunForum comprende cinque elementi: Chiama, Visualizza,

Strumenti, Opzionie Guida.

Nota – La maggior parte delle funzioni dei menu Chiama, Visualizza e Strumenti

sono accessibili anche dai pulsanti del gestore di conferenze di SunForum.

Per maggiori informazioni, vedere “Uso del software SunForum”.

Menu Chiama

TABELLA 2-1 Menu Chiama

Voce di menu Descrizione

Nuova chiamata Effettua una chiamata all'indirizzo indicato. In alternativa all'uso

di questa opzione, è anche possibile fare clic sul pulsante Chiama.

Interrompi la chiamata Annulla la richiesta di chiamata in corso.

Apri conferenza Avvia una conferenza.

Interrompi Termina la chiamata (equivale a fare clic sul pulsante Interrompi).

Non disturbare Blocca le chiamate in arrivo. Resta comunque possibile effettuare

chiamate in uscita.

Crea SpeedDial Crea file di composizione rapida da usare nella rubrica o da

scambiare con altri utenti.

Esegui in background Consente di continuare a eseguire SunForum in background dopo

la chiusura.

Accedi al server di elenchi Connette il sistema ad un server di elenchi. Verrà chiesto di

inserire il nome del server.

Modifica informazioni

personali

Consente di modificare le informazioni del proprio profilo.

Lista di indirizzi Consente di chiamare gli indirizzi utilizzati più di recente.

Esci Chiude o esegue in background la sessione SunForum corrente.
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Menu Visualizza

I pulsanti del menu Visualizza permettono di cambiare le opzioni visualizzate nel

gestore di conferenze di SunForum.

Nota – Per rimuovere un elemento dalle liste Rubrica e Cronologia, selezionare
l’elemento e premere il tasto Delete.

Menu Strumenti

TABELLA 2-2 Menu Visualizza

Voce di menu Descrizione

Vista compatta Trasforma il gestore di conferenze nella barra dei menu.

Sempre sopra Fa sì che la finestra del gestore di conferenze sia sempre in primo piano.

Elenco contatti Visualizza il server di elenchi ed elenca le persone con cui si può

avviare una conferenza.

Rubrica Mostra gli indirizzi delle persone con cui si è partecipato a una

conferenza e che sono stati aggiunti alla rubrica.

Stato della chiamata Durante una chiamata, visualizza lo stato dei partecipanti alla

conferenza e lo stato della condivisione delle applicazioni, della

lavagna e della funzione di conversazione.

Cronologia Visualizza lo stato delle chiamate ricevute.

Aggiorna elenco Interroga il server di elenchi per aggiornarne il contenuto.

Informazione chiamata Visualizza l'utilizzo dell'ampiezza di banda audio/video nella

chiamata corrente.

TABELLA 2-3 Menu Strumenti

Voce di menu Descrizione

Commuta audio e video Consente di passare l’audio e video a un altro partecipante.

Opzione presente solo durante una conferenza.

Video Seleziona le finestre video da visualizzare.

Procedura guidata di

configurazione

Avvia il programma di procedura guidata della configurazione.

Condividi applicazione Consente di condividere le proprie applicazioni con gli altri

partecipanti alla chiamata. Un sottomenu elenca le applicazioni

in esecuzione sul desktop.

Condividi Consente di selezionare sul desktop la finestra dell'applicazione

da condividere (equivale a fare clic sul pulsante Condividi).
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Menu Opzioni

Non condividere Consente di interrompere la condivisione dell'applicazione

(equivale a fare clic sul pulsante Non condividere).

Collabora Cambia lo stato di un'applicazione condivisa dalla modalità di

sola visualizzazione alla modalità di collaborazione. Abilitando

la modalità di collaborazione, si consente ad altre persone di

assumere il controllo dell'applicazione (equivale a fare clic sul

pulsante Collabora).

Invia file Consente di selezionare un file da inviare a tutti i partecipanti

alla conferenza (equivale a fare clic sul pulsante Invia).

Annulla tutti gli invii Annulla le operazioni di invio dei file.

Annulla tutte le ricezioni Annulla le operazioni di ricezione dei file.

Visualizza desktop condivisi Mostra una panoramica dei desktop di tutti gli utenti e la

posizione delle applicazioni condivise.

Lavagna Avvia l'applicazione grafica Lavagna. La lavagna viene avviata

automaticamente anche sui sistemi degli altri partecipanti alla

conferenza (equivale a fare clic sul pulsante Lavagna).

Conversazione Avvia l'applicazione Conversazione. La finestra

dell'applicazione viene aperta automaticamente anche sui

sistemi degli altri partecipanti alla conferenza (equivale a fare

clic sul pulsante Conversazione).

Condividi la clipboard Consente di copiare e incollare i dati tra sistemi.

TABELLA 2-4 Menu Opzioni

Voce di menu Descrizione

Impostazioni chiamata Consente di configurare le opzioni di SunForum per la

gestione delle chiamate.

Impostazioni strumenti Consente di configurare le opzioni generali di SunForum.

Impostazioni audio/video Consente di configurare gli attributi di conferenza audio/

video.

Impostazioni dispositivi

audio/video

Consente di configurare i dispositivi di input e output audio e

il dispositivo di input video, compresa la telecamera Sun Ray

e Sun 1394.

TABELLA 2-3 Menu Strumenti (Continua)

Voce di menu Descrizione
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Menu Guida

Il menu Guida permette di accedere alle informazioni della guida in linea.
Per visualizzare le informazioni in linea su SunForum, scegliere Guida ➤ Argomenti
della Guida.

Nota – Il menu Argomenti della guida è presente nella barra dei menu di tutte le
finestre di SunForum.

Uso degli elenchi

Per impostare un elenco è necessario specificare i propri dati personali, quali nome,

indirizzo e indirizzo di posta elettronica. Queste informazioni vengono richieste al

primo avvio di SunForum. Ogni utente può scegliere se intende abilitare la

visualizzazione di queste informazioni per tutti gli utenti; se tale visualizzazione non

viene abilitata, solo le persone che conoscono l'indirizzo di posta elettronica del

destinatario potranno contattarlo attraverso l'elenco.

In questa sezione vengono descritte le operazioni seguenti:

■ Modificare le informazioni personali per l’elenco

■ Accedere a un server di elenchi

■ Aggiornare il contenuto di un elenco

■ Accedere automaticamente a un server di elenchi all’avvio

■ Rimuovere il proprio nome dal server di elenchi

■ Chiamare un utente incluso nell’elenco

■ Chiamare un utente su un server di elenchi usando un indirizzo di posta

elettronica

▼ Modificare le informazioni personali per l’elenco

1. Scegliere Chiama ➤ Modifica informazioni personali.

Compilare i seguenti campi:

■ Nomee Cognome. Questo sarà il nome usato per identificare l’utente nelle

conferenze.

■ Indirizzo di posta elettronica . Questo indirizzo verrà usato per

identificare l’utente durante l’accesso a un server di elenchi.
Uso di SunForum 9



■ Nome SunForum e Numero SunForum . È necessario che il "Nome SunForum" e

il "Numero SunForum" siano univoci per ciascun utente SunForum. Il server di

elenchi non dispone attualmente di un altro modo per identificare gli utenti

connessi al server. Inoltre, non vi è alcuna connessione tra queste entità e il nome

utente di sistema, il numero di telefono dell’ufficio, ecc. di una persona. Gli utenti

possono comunque decidere di fare coincidere il Nome SunForum con il

rispettivo nome utente e il Numero SunForum con l’interno telefonico.

È importante ricordare che quando si utilizza la modalità "standard" di

esecuzione delle chiamate con SunForum, il numero utilizzato nella chiamata è il

Numero SunForum immesso nelle informazioni utente di SunForum del

destinatario della chiamata. Viceversa, inserendo un numero quando si esegue

una chiamata tramite il gateway il sistema tenta di effettuare una connessione

tramite il sistema telefonico locale, se l’attuale configurazione di sistema di

SunForum consente questa modalità. È bene ricordare tale distinzione quando si

effettuano chiamate a un destinatario il cui numero SunForum è identico al

numero di telefono dell’ufficio.

■ Categoria . Questa informazione viene utilizzata dai server per limitare la lista

dei nomi visualizzati in caso di interrogazione o scelta di un server di elenchi.

2. Modificare le informazioni desiderate e fare clic su OK.

▼ Accedere a un server di elenchi

1. Per visualizzare il contenuto dell’elenco, scegliere Chiama ➤ Accedi al server di
elenchi.

2. Inserire il nome del server di elenchi a cui si desidera accedere, quindi fare clic
su OK.

Quando SunForum si connette al server di elenchi, interroga automaticamente il

server per ottenere i nomi degli altri utenti connessi.

▼ Chiudere la connessione con il server di elenchi

● Per chiudere la connessione con il server di elenchi, scegliere Chiama ➤ Esci dal
server di elenchi.

Nota – Per configurare un server LDAP come server di elenchi SunForum,

consultare la guida in linea di SunForum 3.2 per i dettagli sulle procedure di

amministrazione di sistema necessarie.
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▼ Aggiornare il contenuto di un elenco

● Scegliere Visualizza ➤ Aggiorna elenco.

Questa opzione può essere selezionata solo quando è visualizzato il contenuto di un

elenco.

▼ Accedere automaticamente a un server di

elenchi all’avvio

1. Scegliere Chiama ➤ Modifica informazioni personali.

2. Selezionare “Accedi al server di elenchi all’avvio”.

3. Specificare il nome del server di elenchi a cui si desidera accedere nel campo
Nome del server.

All’avvio successivo di SunForum, il sistema si connetterà al server di elenchi

specificato.

▼ Rimuovere il proprio nome dal server di elenchi

1. Scegliere Chiama ➤ Modifica informazioni personali.

2. Selezionare “Non visualizzare il mio nome durante la connessione al server di
elenchi”.

Alla connessione successiva ad un server di elenchi, i propri dati personali non

saranno visibili per gli utenti che consulteranno l’elenco.

Se questa opzione viene selezionata mentre l'utente è connesso e il suo nome è

visualizzato, SunForum aggiornerà automaticamente i dati del server di elenchi in

modo da non visualizzare il nome di quell'utente.

▼ Chiamare un utente incluso nell’elenco

Per chiamare un utente che compare nell'elenco, è sufficiente fare doppio clic sul suo

nome.

Nota – Se è selezionata l’opzione “Aggiungi alla rubrica” nella finestra Nuova

chiamata (Chiama ➤ Nuova chiamata), gli utenti chiamati attraverso l’elenco

verranno aggiunti alla rubrica.
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▼ Chiamare un utente su un server di elenchi

usando un indirizzo di posta elettronica

SunForum permette di chiamare una persona collegata ad un server di elenchi

specificando il suo indirizzo di posta elettronica.

● Digitare il nome del server di elenchi a cui l'utente è connesso e il suo indirizzo di
posta elettronica separati da una barra (/).

SunForum cercherà nel server di elenchi un utente con l'indirizzo di posta

elettronica specificato. Se l'utente è connesso al server di elenchi, SunForum cercherà

di avviare la chiamata.

Uso del software SunForum

Le procedure descritte in questa sezione fanno riferimento al gestore di conferenze

di SunForum.

In questa sezione vengono descritte le operazioni seguenti:

■ Eseguire una chiamata

■ Condividere le applicazioni

Eseguire una chiamata

▼ Connessione rapida

1. Scegliere Visualizza ➤ Rubrica, oppure fare clic sul pulsante Rubrica.

2. Nella Rubrica, fare doppio clic sulla voce dell’utente con cui si desidera stabilire
una connessione.

È anche possibile fare clic sui pulsanti Elenco contatti o Cronologia e fare doppio clic

sulla voce dell'utente con cui si desidera stabilire la connessione.

▼ Connessione manuale

1. Scegliere Chiama ➤ Nuova chiamata, oppure fare clic sul pulsante Chiama.

Viene visualizzata la finestra Nuova chiamata, dalla quale è possibile avviare una

conferenza.
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2. Inserire l’indirizzo dell’utente con cui si desidera avviare la conferenza.

Nella finestra Nuova chiamata, è possibile aggiungere l’indirizzo che si sta

chiamando alla Rubrica. È anche possibile specificare il nome della conferenza a cui

si desidera partecipare (ad esempio, se si sta chiamando un server di conferenze).

3. Fare clic su OK.

Se la connessione viene stabilita, viene attivata la finestra Stato della chiamata;

diversamente, compare un messaggio che indica la ragione per cui il collegamento

non è riuscito.

▼ Chiudere una connessione

● Scegliere Chiama ➤ Interrompi, oppure fare clic sul pulsante Interrompi.

In questo modo si termina la propria partecipazione a una conferenza.

Nota – Quando un utente termina una connessione, egli disconnette anche i

partecipanti che aveva invitato alla conferenza o le persone che lo avevano chiamato.

Se era stato quell'utente ad avviare la conferenza, l'intera conferenza verrà terminata.

Quando l'uscita di un utente ha l'effetto di terminare la connessione di altre persone,

compare un messaggio di avvertimento.

Nota – È inoltre possibile eseguire le chiamate tramite un gateway (vedere il

Capitolo 4 “Configurazione del software gateway”).

Condividere le applicazioni

▼ Condividere le applicazioni

Quando si utilizza SunForum, è possibile condividere le applicazioni dell'intero

desktop con gli altri partecipanti alla conferenza. In particolare:

■ Se un utente che dispone del controllo all'interno di una conferenza di SunForum

sposta la finestra di un'applicazione sul suo desktop, la finestra viene

effettivamente spostata sul desktop dell'host. È possibile che altre applicazioni

presenti sul desktop dell'host oscurino la finestra condivisa. In questo caso, se una

parte della finestra dell'applicazione condivisa è oscurata sul desktop dell'host, la

stessa parte appare oscurata anche sul desktop dell'utente che ha il controllo.
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■ Gli schermi dei desktop Sun e PC che partecipano a una conferenza SunForum

possono avere dimensioni differenti. Questo comporta che, quando un utente in

fase di controllo sposta le finestre condivise sul suo desktop, tali finestre possono

fuoriuscire dall'area di visualizzazione di un utente con uno schermo più piccolo.

In questi casi, i partecipanti con lo schermo più piccolo possono spostare (scorrere)

l'area di visualizzazione attiva dello schermo spostando il puntatore del mouse

in modo da rendere visibile l'intera applicazione. Per impostare la funzione di

scorrimento, scegliere Strumenti ➤ Opzioni dal gestore di conferenze di SunForum.

1. Durante una conferenza, scegliere Strumenti ➤ Condividi, oppure fare clic sul
pulsante Condividi.

In alternativa, scegliere Strumenti ➤ Condividi applicazione per selezionare

l’applicazione che si desidera condividere.

2. Posizionare il puntatore del mouse (che ora avrà la forma di una mano con l’indice
puntato) sulla finestra dell’applicazione desktop che si desidera condividere.

3. Fare clic in qualsiasi punto all’interno di quella finestra.

Tutti i partecipanti alla conferenza potranno vedere l'applicazione sul proprio sistema

come se fosse in esecuzione localmente. SunForum può condividere quasi tutte le

applicazioni, incluse le finestre di terminale, i word processor e i pacchetti di disegno

CAD. Fanno eccezione SunForum e alcune estensioni X che non sono supportate.

Nota – La finestra avrà il nome dell'utente che ha avviato la condivisione

dell'applicazione. A questo punto, solo quella persona può avere il controllo

dell'applicazione; gli altri utenti possono solo visualizzare l'output sul proprio desktop.

▼ Terminare la connessione delle applicazioni

1. Scegliere Strumenti ➤ Non condividere, o fare doppio clic sul pulsante Non
condividere, per terminare la condivisione delle applicazioni.

2. Fare clic sulla finestra dell’applicazione che veniva condivisa.

A questo punto, solo l'utente originario potrà visualizzare e controllare

l'applicazione.
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▼ Attivare la modalità di collaborazione

Quando un'applicazione è condivisa viene attivato il pulsante Collabora, che

permette di rendere disponibile l'applicazione ai partecipanti che intendono

collaborare alla conferenza.

1. Condividere un’applicazione (vedere la sezione Condividere le applicazioni).

2. Scegliere Strumenti ➤ Collabora, oppure fare clic sul pulsante Collabora.

L'applicazione condivisa che in precedenza era accessibile ai partecipanti alla

conferenza solo in modalità di visualizzazione può essere ora utilizzata in modo

collaborativo.

La modalità di collaborazione permette agli altri partecipanti alla conferenza di

assumere il controllo dell'applicazione. Per assumere il controllo dell'applicazione

condivisa, un partecipante dovrà semplicemente fare clic su quell'applicazione sul

proprio desktop.

Nota – Quando un altro partecipante alla conferenza assume il controllo

dell'applicazione condivisa facendo clic sulla sua finestra, egli rileva effettivamente

il controllo degli input con il mouse e la tastiera. L'applicazione può essere

controllata da un solo utente alla volta. Il controllo può essere assunto da qualunque

altro utente, incluso l'host, con un semplice clic del mouse.

● Per interrompere la collaborazione, fare clic nuovamente su Collabora.

L'applicazione condivisa torna ad essere accessibile agli altri partecipanti in modalità

di sola visualizzazione.

▼ Trasferire i file

1. Scegliere Strumenti ➤ Invia file, oppure fare clic su Invia file.

Viene visualizzata la finestra Selezionare il file da inviare.

2. Spostarsi nella directory appropriata e selezionare il file da inviare.

3. Fare clic su OK.

Il file verrà inviato a tutti i partecipanti alla conferenza.

I file inviati dagli altri partecipanti alla conferenza verranno ricevuti

automaticamente. Durante la ricezione del file, una finestra mostra lo stato di

avanzamento dell'operazione. Al termine del trasferimento, il file viene salvato.

La directory predefinita per il salvataggio dei file è /tmp . Per modificare la directory

predefinita per il salvataggio, scegliere Opzioni ➤ Impostazioni strumenti.
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▼ Attivare una conversazione

1. Scegliere Strumenti ➤ Conversazione, oppure fare clic sul pulsante Conversazione
per avviare l’applicazione corrispondente.

L'applicazione di conversazione viene avviata automaticamente anche sui sistemi

degli altri partecipanti alla conferenza.

2. Selezionare il destinatario del messaggio.

■ Per inviare un messaggio a tutti i partecipanti, scegliere Invia a ➤ Tutti i

partecipanti alla conferenza (Everyone in conference).

■ Per inviare un messaggio a un unico partecipante, scegliere Invia a ➤ nome utente.

Nel menu Invia a vengono elencati i nomi dei partecipanti alla conferenza che hanno

in esecuzione l'applicazione di conversazione.

3. Digitare il messaggio nell’apposito campo e premere Return.

Il messaggio viene visualizzato nella propria finestra di conversazione e in quella

degli altri partecipanti.

Insieme al messaggio è possibile visualizzare la data, l'ora e il nome dell'utente.

A tale scopo, fare clic su Visualizza nella barra dei menu dell'applicazione di

conversazione e selezionare o deselezionare le opzioni desiderate.

Le sessioni di conversazione possono essere salvate in un file sotto forma di verbale

della conferenza. Tale opzione sarà offerta all'uscita della finestra di conversazione.

Nota – Non tutti i prodotti che dispongono di una funzionalità di conversazione

T.120 possono interoperare con l'applicazione di conversazione di SunForum.

Per determinare quali utenti abbiano accesso alla funzione di conversazione,

controllare lo stato della funzione nel gestore di conferenze di SunForum.

▼ Trasferire i dati usando la clipboard condivisa

1. Abilitare la condivisione della clipboard su entrambi i sistemi.

2. Scegliere Strumenti ➤ Condividi la clipboard.

L'opzione di condivisone della clipboard deve essere attiva (selezionata).

Nota – Per abilitare automaticamente la condivisione della clipboard, scegliere

Strumenti ➤ Opzioni.

3. Selezionare un testo da un'applicazione (ad esempio da una finestra di comando) su
uno dei sistemi.

4. Scegliere Modifica ➤ Copia.

5. In un’applicazione (ad esempio, un editor di testo) di un altro sistema, scegliere
Modifica ➤ Incolla.
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Uso di video e audio in SunForum

Il protocollo di comunicazione audio e video H.323 è lo standard per le funzioni di

conferencing audio/video. SunForum è conforme allo standard H.323.

In questa sezione verranno trattati gli argomenti seguenti:

■ Tipi di conferenze audio/video

■ Configurazione delle capacità audio/video

■ Impostare le opzioni audio/video

■ Impostare le opzioni dei dispositivi audio/video

■ Gestione dell’adio durante le conferenze

■ Gestione del video durante le conferenze

■ Gestione del video durante le conferenze multipunto

■ Gestione del video durante le conferenze punto-punto

Tipi di conferenze audio/video

I prodotti di conferencing possono fornire tre livelli diversi di supporto audio/video.

■ Multipunto - L'utente può vedere e ascoltare diversi partecipanti alla conferenza

contemporaneamente. L'immagine video di ciascun partecipante viene

visualizzata in una finestra separata, mentre le informazioni audio dei singoli

partecipanti vengono unite in modo da ottenere un unico canale audio con le voci

di tutti i partecipanti.

■ Punto-punto - L'utente può vedere e ascoltare un partecipante alla conferenza per

volta e può passare da un partecipante all'altro.

■ Senza audio/video - L'utente non può vedere né ascoltare gli altri partecipanti alla

conferenza. Gli utenti dei prodotti di conferencing che non supportano le capacità

audio/video spesso predispongono una conferenza telefonica parallela alla

conferenza in SunForum.

SunForum offre il supporto multipunto, ma è in grado di funzionare anche in

modalità punto-punto o senza audio/video per consentire lo svolgimento di

conferenze con altri prodotti:

■ Se tutti i partecipanti alla conferenza utilizzano un prodotto che supporta le

capacità audio/video multipunto, è possibile adottare la modalità sia multipunto

che punto-punto (può essere preferibile usare il punto-punto con i partecipanti

che hanno familiarità con i prodotti che funzionano soltanto in questa modalità).
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■ Se alcuni partecipanti utilizzano un prodotto che supporta soltanto le capacità

audio/video punto-punto, è necessario adottare la modalità punto-punto.

SunForum può essere configurato in modo da imporre il punto-punto nelle

conferenze per consentire ai partecipanti dotati esclusivamente di prodotti punto-

punto di stabilire connessioni audio/video.

■ I partecipanti che utilizzano un prodotto che non supporta le capacità audio/

video possono in ogni caso prendere parte alla conferenza, sebbene non possano

vedere né ascoltare gli altri partecipanti. L'utente può tuttavia continuare a

utilizzare le capacità audio/video per comunicare con i partecipanti alla

conferenza che li supportano.

Quando viene eseguita una chiamata a un altro utente, SunForum stabilisce

inizialmente una connessione audio/video punto-punto, a prescindere dalle capacità

dell'altro prodotto. Se un terzo utente interviene alla conferenza, le capacità

disponibili determineranno se la conferenza può adottare la modalità multipunto o

rimanere nella modalità punto-punto. Dopo l'adozione della modalità multipunto,

i prodotti che non supportano questa modalità non potranno stabilire alcuna

connessione audio/video con la conferenza.

Per avviare una conferenza esplicitamente in modalità punto-punto, è possibile

specificare l'impostazione appropriata nella finestra di dialogo Impostazioni audio/

video. Per maggiori informazioni, vedere Impostare le opzioni dei dispositivi audio/

video.

Nella finestra della chiamata corrente, le icone audio/video indicano una connessione

audio/video a un partecipante alla conferenza.

FIGURA 2-3 Icone di gestione audio/video della conferenza
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Configurazione delle capacità audio/video

▼ Impostare le opzioni audio/video

● Scegliere Opzioni ➤ Impostazioni audio/video.

In alternativa, scegliere Visualizza ➤ Impostazioni audio/video nella finestra video

personale o nelle finestre video degli altri partecipanti alla conferenza.

TABELLA 2-5 Opzioni audio e video

Voce di menu Descrizione

Usa connessioni A/

V punto-punto

Questa opzione consente di utilizzare soltanto connessioni punto-

punto per le conferenze audio/video. In tal modo, gli utenti dotati

soltanto di capacità punto-punto possono utilizzare l'audio e il video

come parte della conferenza.

Invia dimensioni

immagine

Specifica le dimensioni dell'immagine video nel modo in cui appare

agli altri partecipanti. Questa opzione determina inoltre le dimensioni

della finestra Video personale. La gamma di dimensioni di finestra

che è possibile usare dipende dalle capacità dei prodotti di

conferencing impiegati dagli altri partecipanti. Se è già in corso una

conferenza, è possibile che una o più di queste opzioni siano inattive

se gli altri partecipanti impiegano prodotti di conferencing che non le

supportano. Può accadere che le dimensioni della finestra vengano

modificate all'inizio di una chiamata o nel momento in cui un altro

partecipante interviene o abbandona la conferenza. Ciò è dovuto al

fatto che alcuni dei partecipanti potrebbero non essere in grado di

utilizzare le dimensioni inizialmente selezionate; SunForum

interagisce con gli altri prodotti di conferencing in modo da

selezionare il compromesso migliore tra i requisiti dei partecipanti alla

conferenza.

Ingrandimento

predefinito video

Questa opzione specifica la percentuale di ingrandimento predefinita

(100% - 400%) per la visualizzazione video sul sistema.

Preferenze di

ricezione

Questa opzione consente di impostare in dettaglio la qualità

dell'immagine video di altri utenti appena questi appaiono sullo

schermo.

- Spostare la casella di scorrimento verso Video più rapido per

visualizzare il video con aggiornamenti più frequenti al secondo.

In tal modo, si ottiene una visualizzazione più continua, ma si

riduce la risoluzione dell'immagine.

- Spostare la casella di scorrimento verso Qualità migliore per

visualizzare il video con una risoluzione più alta.

In tal modo, si ottiene un'immagine video di qualità migliore, ma la

visualizzazione risulta meno continua.
Uso di SunForum 19



▼ Impostare le opzioni dei dispositivi audio/video

● Scegliere Opzioni ➤ Impostazioni dispositivi audio/video.

Uso della funzione “Snap” della Sun 1394 Camera

È possibile scattare un'istantanea direttamente dalla Sun 1394 Camera. Ciò permette

di catturare un'immagine da qualsiasi posizione entro un raggio di 3 metri dalla

workstation (pari alla lunghezza del cavo della 1394). Questa funzione è attivabile

tramite SunForum (vedere la sezione “Cattura e copia di immagini video” a

pagina 30).

Gestione dell’audio durante le conferenze

Durante le conferenze è possibile regolare l'audio inviato agli altri partecipanti e

l'audio ricevuto dagli altri partecipanti.

Velocità di

connessione

Selezionare l'opzione che corrisponde alla rete su cui si utilizza

SunForum 3.2.

Soppressione

dell’eco

Selezionando questa opzione, SunForum 3.2 disattiva il microfono

durante la riproduzione audio. Quest’opzione, chiamata anche half-

duplex, è utile quando si utilizzano altoparlanti invece delle cuffie.

Controllo

automatico volume

Selezionando questa opzione, SunForum 3.2 regola automaticamente

la sensibilità del microfono basandosi sul livello di ingresso.

TABELLA 2-6 Opzioni dei dispositivi audio e video

Voce di menu Descrizione

Dispositivo audio Consente di scegliere il dispositivo audio da usare durante la conferenza

e gli attributi associati a tale dispositivo. Occorre prima selezionare il

dispositivo audio da usare dal menu e quindi premere il pulsante

“Impostazioni” per configurare gli attributi specifici del dispositivo.

Ciascun dispositivo è un attributo univoco che è possibile configurare.

Dispositivo video Consente di scegliere il dispositivo video da usare durante la conferenza

e gli attributi associati a tale dispositivo. L'opzione “Nessuno” riguarda

i sistemi privi di capacità di cattura video o impostati in modo da

disattivarle. Occorre prima selezionare il dispositivo video da usare dal

menu e quindi premere il pulsante “Impostazioni” per configurare gli

attributi specifici del dispositivo. Ciascun dispositivo è un attributo

univoco che è possibile configurare.

TABELLA 2-5 Opzioni audio e video (Continua)

Voce di menu Descrizione
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Regolare l’audio durante le conferenze

La casella a sinistra dell'icona Microfono gestione conferenza indica se l'audio

dell'utente viene riprodotto nei computer degli altri partecipanti.

■ Per avviare o interrompere la riproduzione dell'audio dell'utente nei computer

degli altri partecipanti, fare clic sulla casella di controllo a sinistra dell'icona.

■ Per regolare il livello di output dell'audio dell'utente, spostare la casella di

scorrimento verso destra per aumentare l'audio o verso sinistra per diminuirlo.

Si tratta di un'operazione importante durante le conferenze multipunto in cui

questa casella di scorrimento determina il volume dell'audio in relazione

all'audio degli altri partecipanti.

■ Se si utilizza la modalità audio/video punto-punto, soltanto il partecipante

corrente può ricevere l'audio dell'utente. Per passare a un partecipante diverso

della conferenza, vedere Gestione del video durante le conferenze punto-punto.

Regolare l’audio della conferenza sul proprio

computer

La casella di controllo a sinistra dell'icona Altoparlante indica se l'audio degli altri

partecipanti viene riprodotto nel computer dell'utente.

■ Per avviare o interrompere la riproduzione audio degli altri partecipanti, fare clic

sulla casella di controllo a sinistra dell'icona.

■ Per regolare il livello di output, spostare la casella di scorrimento verso destra per

aumentare il volume o verso sinistra per diminuirlo.

■ Se si utilizza la modalità audio/video punto-punto, l'utente riceve soltanto l'audio

dell'utente corrente. Per passare a un partecipante diverso della conferenza, vedere

Gestione del video durante le conferenze punto-punto.

Gestione dell’immagine video durante le

conferenze

Prima di iniziare una chiamata con video, è possibile verificare la propria immagine

video che verrà visualizzata sugli schermi degli altri partecipanti (ad esempio, per

assicurarsi che la videocamera del sistema sia posizionata correttamente). L'immagine

video sullo schermo appare in una finestra denominata Video personale. Questa

finestra può essere visualizzata o nascosta in qualsiasi momento.
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▼ Regolare la propria immagine video prima di una conferenza

● Scegliere Strumenti ➤ Video ➤ Visualizza video personale.

Per nascondere la finestra, è inoltre possibile chiuderla. Prima di eseguire la

chiamata viene visualizzato il messaggio Invio non in corso sotto la finestra

Video personale.

Nota – SunForum 3.2 permette di ingrandire la finestra di visualizzazione video.

Regolare la propria immagine video durante una

conferenza

Durante la chiamata viene visualizzato un pulsante aggiuntivo accanto al messaggio

di stato, nella parte inferiore della finestra Video personale. Il messaggio di stato

riflette lo stato corrente della trasmissione video. Il pulsante consente di modificare

lo stato come segue:

■ Se lo stato del video è “Invio in corso”, viene mostrato il pulsante Pausa. Fare clic

su questo pulsante per interrompere temporaneamente la visualizzazione video.

Quando viene interrotta la visualizzazione, nella finestra viene eseguito un “fermo

immagine” del partecipante e il messaggio di stato diventa “Pausa in corso”.

■ Se lo stato del video è “Pausa in corso”, viene mostrato il pulsante Riproduzione.

Fare clic su questo pulsante per attivare la visualizzazione video. Quando viene

attivata la visualizzazione, il video viene riavviato e il messaggio di stato diventa

“Invio in corso”.

Al posto dei pulsanti Pausa/Riproduzione della finestra, è possibile usare le opzioni

corrispondenti comprese nel menu Visualizza di questa finestra. Queste opzioni

appaiono soltanto quando è in corso una chiamata.

È possibile stabilire se l'immagine video viene inviata automaticamente agli altri

partecipanti non appena inizia una chiamata; per maggiori informazioni, vedere

Impostare le opzioni dei dispositivi audio/video.
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Gestione dell’immagine video durante le

conferenze multipunto

Se si utilizza la modalità audio/video multipunto, l'immagine video di ciascun

partecipante alla conferenza viene automaticamente visualizzata appena questi

inizia a inviare dati video.

■ L'immagine di ciascun partecipante viene visualizzata in una finestra separata, la

quale riporta il nome del partecipante. Quando intervengono nuovi partecipanti o

altri escono dalla conferenza, vengono create nuove finestre o quelle esistenti

vengono chiuse.

■ È possibile scegliere le finestre da visualizzare sul proprio schermo.

▼ Regolare l’immagine video durante una conferenza multipunto

● Scegliere Strumenti ➤ Video ➤ Visualizza video di altri.

Fare clic su una voce relativa alla finestra da visualizzare o nascondere. In

alternativa, è possibile nascondere una finestra visualizzata chiudendola mediante il

menu di sistema.

Nella parte inferiore di ciascuna di queste finestre, un pulsante indica se l'immagine

video viene visualizzata, come segue:

■ Se lo stato del video è “Ricezione in corso”, viene mostrato il pulsante Pausa.

Fare clic su questo pulsante per interrompere temporaneamente la

visualizzazione video. Quando viene interrotta la visualizzazione, nella finestra

viene eseguito un “fermo immagine” del partecipante e il messaggio di stato

diventa “Pausa in corso”.

■ Se lo stato del video è “Pausa in corso”, viene mostrato il pulsante Riproduzione.

Fare clic su questo pulsante per attivare la visualizzazione video. Quando viene

attivata la visualizzazione, il video viene riavviato e il messaggio di stato diventa

“Ricezione in corso”.

È possibile stabilire se visualizzare automaticamente le immagini video degli altri

partecipanti non appena questi iniziano a inviarle; per maggiori informazioni,

vedere Impostare le opzioni audio/video. Se si decide di non visualizzare queste

immagini, le finestre dei partecipanti remoti sullo schermo rimangono vuote fino a

quando non si preme il pulsante Riproduzione per avviare la visualizzazione video.

Al posto dei pulsanti Pausa/Riproduzione nella finestra, è possibile usare le opzioni

corrispondenti comprese nel menu Visualizza di questa finestra.

Nota – Le dimensioni della finestra usate per visualizzare le immagini video degli

altri partecipanti dipendono dal prodotto di conferencing da questi impiegato.
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Gestione del video durante le conferenze punto-

punto

Nella modalità audio/video punto-punto, è possibile vedere e ascoltare soltanto un

partecipante alla conferenza per volta. È possibile passare da un partecipante

all'altro; se si passa a un partecipante diverso, il partecipante precedente rimane

nella conferenza ma nessuno riceve i suoi segnali.

Nota – Non è possibile tentare di passare a un partecipante i cui segnali vengono

già ricevuti da altri.

▼ Passare a un altro partecipante

● Scegliere Strumenti ➤ Commuta audio e video.

Questa opzione visualizza un elenco di partecipanti a cui è possibile passare,

compreso il partecipante corrente (contrassegnato da un segno di spunta).

L'elenco non comprende i partecipanti privi di capacità audio/video.

■ Per passare a un partecipante diverso, fare clic sul relativo nome nell'elenco.

■ Per escludersi in modo da rimanere nella conferenza senza conversare con alcun

partecipante in particolare, fare clic sul nome del partecipante corrente

(contrassegnato dal segno di spunta).

L'opzione di menu Commuta audio e video appare soltanto durante le conferenze

con più partecipanti dotati di capacità audio/video, nelle connessioni punto-punto.

Visualizzazione del video remoto durante le

conferenze punto-punto

Se si utilizza la modalità audio/video punto-punto, la finestra Video remoto visualizza

un'immagine video del partecipante corrente (se esistente).

■ Per passare a un partecipante diverso, vedere Gestione del video durante le

conferenze punto-punto.

■ È possibile scegliere se visualizzare questa finestra sul proprio schermo mediante

Video remoto.

▼ Visualizzare il video remoto

● Scegliere Strumenti ➤ Video ➤ Visualizza video remoto.

Questa opzione visualizza o interrompe la visualizzazione della finestra. In alternativa,

è possibile chiudere la finestra facendo clic sul pulsante Chiudi della finestra.
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Uso della lavagna di SunForum

La Lavagna di SunForum permette a tutti i partecipanti a una conferenza di

scambiarsi idee e grafici. Per poter usare la lavagna, tuttavia, non è necessario

partecipare a una conferenza.

In SunForum sono disponibili due tipi di lavagna:

■ La modalità T.126, che permette di interoperare con qualsiasi sistema o dispositivo

che utilizzi il protocollo T.126 indipendentemente dal software della piattaforma

■ La modalità SunForum 1.0, che permette di interoperare con i PC che utilizzano

alcune applicazioni di collaborazione.

In questa sezione vengono descritte le operazioni seguenti:

■ Selezionare la modalità della lavagna

■ Disegnare oggetti grafici

■ Usare oggetti di testo

■ Spostare ed eliminare oggetti

■ Evidenziare testo e immagini

■ Catturare immagini video

■ Inserire immagini catturate nella lavagna

■ Importare immagini grafiche

■ Esportare immagini grafiche

■ Usare il puntatore remoto

■ Usare i timbri

■ Copiare nella clipboard

■ Consultare e organizzare le pagine

■ Aggiungere una nuova pagina

■ Ingrandire la lavagna

■ Bloccare la lavagna

■ Salvare il contenuto della lavagna in un file

■ Stampare il contenuto della lavagna
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▼ Selezionare la modalità della lavagna

1. Scegliere Opzioni ➤ Impostazioni strumenti.

2. Scegliere la modalità desiderata per la lavagna: T.126 o SunForum 1.0.

3. Fare clic su OK.

Nota – Dopo avere selezionato una modalità nella finestra Opzioni, la lavagna si

aprirà in quella modalità ogni volta che verrà avviata con l'opzione Lavagna

(Whiteboard) del menu Strumenti o con il pulsante Lavagna nel gestore di

conferenze di SunForum. Vedere Avviare la lavagna.

▼ Avviare la lavagna

● Scegliere Strumenti ➤ Lavagna, oppure fare clic sul pulsante Lavagna dal gestore
di conferenze di SunForum.

La lavagna verrà aperta nella modalità selezionata nella finestra Opzioni. In questo

esempio viene mostrata la lavagna in modalità SunForum T.126.

FIGURA 2-4 Lavagna di SunForum 3.2
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Menu della lavagna

Pannello degli strumenti della lavagna

Per familiarizzare con la lavagna, provare ad usare le funzioni di disegno accessibili

dal pannello degli strumenti posto sulla sinistra della finestra. Per usare queste

funzioni non è necessario partecipare a una conferenza.

FIGURA 2-5 Pannello degli strumenti della lavagna

TABELLA 2-7 Descrizione della barra dei menu della lavagna

Menu Descrizione

File Funzioni di gestione dei file, come Nuovo, Apri, Salva, Importa, Esporta e

Stampa.

Modifica Funzioni di modifica, con cui copiare, incollare, cancellare, eliminare, inserire

pagine e così via.

Strumenti Funzioni di disegno. È inoltre possibile fare clic sull'icona nel pannello degli

strumenti di disegno a sinistra della lavagna.

Selettore

Penna

Linea

Rettangolo

Ellisse vuota

Seleziona

Blocca contenuto

Modalità SunForum 1.0

Testo

Evidenziatore

Zoom

Rettangolo

Ellisse piena

Puntatore

Seleziona area

Modalità T.126

Aggancia video Attiva pulsante

vuoto pieno

finestra

personale

remoto

videocamera

Selettore

Penna

Linea

Rettangolo

Ellisse vuota

Seleziona

Puntatore

Aggancia video

vuoto

finestra

personale

remoto

Testo

Evidenziatore

Zoom

Rettangolo

Ellisse piena

Seleziona area

Attiva pulsante

pieno

videocamera
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▼ Disegnare oggetti grafici

1. Fare clic sul tipo di strumento desiderato nel pannello degli strumenti della lavagna.

Ad esempio, per eseguire un disegno a mano libera, fare clic sullo strumento Penna

o scegliere Strumenti ➤ Penna dalla barra dei menu.

2. Scegliere il colore della penna e la larghezza del tratto.

a. Fare clic sul pulsante Opzioni della lavagna nella parte inferiore della finestra
della lavagna.

FIGURA 2-6 Pulsante Opzioni della lavagna

Viene visualizzata la finestra Opzioni della lavagna.

FIGURA 2-7 Finestra Opzioni della lavagna

b. Scegliere il colore della penna e la larghezza del tratto, quindi fare clic su OK.

3. Premere il pulsante del mouse e trascinare il puntatore per disegnare l’oggetto.

Rilasciando il pulsante del mouse, l'oggetto diventerà visibile agli altri partecipanti

alla conferenza.
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Usare oggetti di testo

Creazione di un oggetto di testo

1. Fare clic sul pulsante dello strumento Testo, oppure scegliere Strumenti ➤ Testo.

2. Posizionare il puntatore del mouse nel punto della lavagna in cui si desidera
inserire il testo.

3. Fare clic in questo punto.

Nella lavagna viene visualizzato un campo di testo.

4. Inserire il testo, quindi fare clic su OK.

Modifica di un oggetto di testo

1. Fare clic sul pulsante dello strumento Testo, oppure scegliere Strumenti ➤ Testo.

2. Fare clic sul testo nella lavagna che si desidera modificare.

Nella lavagna viene visualizzato un campo di testo.

3. Modificare il testo, quindi fare clic su OK.

Impostazione del font e dello stile degli oggetti di testo

Le caratteristiche dei font possono essere impostate in due modi:

■ Modificando le impostazioni nelle opzioni della lavagna prima di creare un

nuovo oggetto di testo.

■ Selezionando un oggetto di testo e quindi cambiando le impostazioni nelle

opzioni della lavagna.

■ Selezionando un oggetto di testo e quindi cambiando le impostazioni nella

finestra per l'inserimento del testo.

1. Fare clic sul pulsante Opzioni della lavagna.

Viene visualizzata la finestra Opzioni della lavagna.

2. Fare clic sui menu Font testo, Dimensioni testo e Stile testo e scegliere le
impostazioni desiderate per il font.

Nota – È disponibile solo un numero limitato di font, per garantire che gli oggetti di

testo possano essere visualizzati sui sistemi di tutti i partecipanti alla conferenza.

3. Fare clic su OK nella finestra Opzioni della lavagna.
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▼ Spostare ed eliminare oggetti

1. Fare clic sul pulsante dello strumento di selezione, oppure scegliere Strumenti ➤

Selettore.

2. Fare clic sull’immagine grafica o sul testo che si desidera spostare o eliminare.

Il bordo dell’oggetto selezionato appare evidenziato.

a. Per spostare l’immagine o il testo, trascinarli con il puntatore del mouse nella
nuova posizione.

b. Per eliminare l’immagine o il testo, premere Delete sulla tastiera, oppure
scegliere Modifica ➤ Elimina.

Nota – Se si è eliminato erroneamente un oggetto, è possibile annullare l'ultima

operazione di eliminazione scegliendo Modifica ➤ Ripristina.

▼ Evidenziare testo e immagini

1. Fare clic sul pulsante dell’evidenziatore, oppure scegliere Strumenti ➤

Evidenziatore.

2. Passare l’evidenziatore sull’area della lavagna che si desidera evidenziare.

Cattura e copia di immagini video

È possibile catturare un'immagine video sia dalla finestra degli strumenti della

lavagna che utilizzando il pulsante “Snap” della Sun 1394 Camera, quindi copiarla

come immagine e inserirla nella lavagna.

▼ Catturare un’immagine dalla finestra degli strumenti della
lavagna

1. Selezionare l’immagine video da catturare.

2. Fare clic su Aggancia video personale dalla finestra degli strumenti della lavagna
(vedere la FIGURA 2-5), oppure scegliere Strumenti ➤ Aggancia video personale.

Comparirà l’immagine, che verrà quindi copiata nell’angolo superiore sinistro della

finestra della lavagna.
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▼ Catturare un’immagine con la Sun 1394 Camera

1. Fare clic sullo strumento Attiva pulsante videocamera nella finestra degli
strumenti della lavagna (vedere la FIGURA 2-5).

Si attiverà il pulsante di cattura della Sun 1394 Camera, così che ad ogni sua pressione

venga catturata l'immagine presente sulla lavagna.

2. Mettere a fuoco l’immagine da catturare e premere il pulsante della Sun 1394
Camera.

Il pulsante di cattura si disattiva se non viene utilizzato per 60 secondi.

Nota – Per disattivare il pulsante di cattura prima dello scadere del periodo di

timeout, è sufficiente premere il tasto Esc.

Inserire un’immagine catturata nella lavagna

È possibile catturare il contenuto di una finestra o un'area del desktop e inserirla

nella lavagna durante una conferenza.

Selezione e cattura di una finestra

1. Fare clic sul pulsante Seleziona finestra, oppure scegliere Strumenti ➤ Seleziona
finestra.

La lavagna diventa un’icona e il puntatore del mouse assume la forma di una mano.

2. Posizionare il puntatore del mouse sulla finestra che si desidera inserire nella
lavagna.

3. Fare clic sulla finestra.

La finestra viene catturata e inserita nella lavagna.

Selezione e cattura di un’area dello schermo

1. Fare clic sul pulsante Seleziona finestra, oppure scegliere Strumenti ➤ Seleziona
area.

La lavagna diventa un'icona e il puntatore del mouse assume la forma di una croce.

2. Trascinare il puntatore del mouse sull'area del desktop che si desidera catturare.

Rilasciando il pulsante del mouse, l'area dell'immagine viene catturata e inserita

nella lavagna.
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Nota – Dopo avere catturato l'immagine nella lavagna, è possibile usare lo

strumento di selezione per selezionare l'immagine e quindi spostarla nella lavagna o

eliminarla. Vedere Spostare ed eliminare oggetti.

▼ Importare immagini grafiche

1. Scegliere File ➤ Importa.

Viene visualizzata una finestra per la selezione del file da importare.

2. Specificare il file che si desidera importare, quindi fare clic su OK.

L’immagine viene inserita nella pagina corrente.

Nota – Per poter importare i file PostScript nella lavagna, è necessario disporre del

filtro shareware ghostscript . La posizione di ghostscript deve essere

specificata separatamente in /etc/opt/SUNWdat/config/system-config come

Whiteboard.GSPath.

▼ Esportare immagini grafiche

1. Scegliere File ➤ Esporta.

Viene visualizzata la finestra per la selezione dei file da esportare.

2. Specificare il file che si desidera esportare.

3. Scegliere il formato dell’immagine dal menu Salva il file in formato.

4. Fare clic su OK.

Il contenuto della pagina corrente viene scritto nel file nel formato selezionato.

▼ Usare il puntatore remoto

Il puntatore remoto è il simbolo a forma di mano con l'indice puntato visibile a tutti i

partecipanti alla conferenza. Abilitando lo strumento di selezione, è possibile fare clic

sul puntatore e trascinarlo sul desktop per indicare le aree di interesse nella pagina.

1. Fare clic sul pulsante del puntatore remoto, oppure scegliere Strumenti ➤

Puntatore remoto.

Sulla lavagna compare un simbolo a forma di mano con l’indice puntato.

2. Fare clic sul puntatore remoto e trascinarlo per selezionare le aree di interesse.
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▼ Usare i timbri

La finestra Timbri della lavagna offre una serie di “timbri” che è possibile applicare

sulla lavagna. Queste immagini sono configurabili dall'utente. Il software SunForum

permette di usare file bitmap (ad esempio GIF) in posizioni definite dall'utente.

Nota – Le immagini usate per i timbri si trovano in /etc/opt/SUNWdat/config/
dcgx , denominate da Whiteboard.StampFilename.1 a

Whiteboard.StampFilename.12 . È tuttavia possibile avere più di 12 timbri.

1. Fare clic sul pulsante del timbro.

FIGURA 2-8 Pulsante del timbro

Viene visualizzata la finestra Timbri della lavagna.

FIGURA 2-9 Finestra Timbri della lavagna

2. Fare clic su un timbro, quindi fare clic su OK.

Posizionando il puntatore sulla lavagna, esso assume la forma di un timbro.
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3. Posizionare il puntatore nel punto della lavagna in cui si desidera collocare
l’immagine e fare clic.

Viene visualizzata l’immagine del timbro.

Copiare nella clipboard

Le operazioni Taglia e Incolla da e verso la clipboard possono essere eseguite in due

modi:

■ Usando il metodo rapido per copiare il testo

■ Usando i comandi del menu Modifica (Edit) per tagliare e incollare testo e grafica.

Uso del metodo rapido per la copia del testo

1. Selezionare un testo nella lavagna (o in un'altra finestra sorgente) o in un'altra
applicazione.

2. Posizionare il puntatore del mouse nella lavagna e fare clic sul pulsante centrale
per incollare il testo selezionato.

Uso dei comandi del menu Modifica

1. Selezionare il testo o l’oggetto che si desidera copiare.

2. Scegliere Modifica ➤ Taglia o Modifica ➤ Copia.

3. Spostarsi in un’altra pagina e scegliere Modifica ➤ Incolla.

▼ Consultare e organizzare le pagine

● Per spostarsi tra le pagine, usare le frecce di navigazione situate nella parte
inferiore della lavagna, oppure usare il menu Modifica per cancellare, eliminare,
inserire le pagine o per spostarsi a una pagina specifica.

● Per organizzare le pagine, scegliere Modifica ➤ Avanti o Modifica ➤ Indietro per
spostare la pagina corrente nella direzione desiderata.
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▼ Aggiungere una nuova pagina

● Fare clic sul pulsante di pagina nuova, nell’angolo inferiore destro della lavagna,
oppure scegliere Modifica ➤ Inserisci pagina.

La nuova pagina verrà aggiunta dopo la pagina corrente.

FIGURA 2-10 Pulsante Nuova pagina

Nota – Usando il menu, si potrà scegliere se inserire la nuova pagina prima o dopo

la pagina corrente.

▼ Ingrandire la lavagna

● Fare clic sul pulsante di zoom, oppure scegliere Strumenti ➤ Zoom.

In questo modo si cambia l’ingrandimento del contenuto della lavagna che si sta

visualizzando.

▼ Bloccare la lavagna

La lavagna può essere bloccata in modo che nessuno degli altri partecipanti alla

conferenza possa modificarne il contenuto.

1. Fare clic sul pulsante di blocco, oppure scegliere Strumenti ➤ Blocca contenuto.

Dopo qualche istante, la lavagna verrà bloccata (tale stato verrà indicato dalla

posizione “premuta” del pulsante), o comparirà un messaggio indicante che non è

stato possibile eseguire l'operazione. Ad esempio, il blocco non può essere applicato

quando un altro partecipante alla conferenza ha già usato questa opzione o sta

eseguendo un'operazione che non può essere interrotta.

2. Per sbloccare, fare clic una seconda volta sul pulsante di blocco.

Nota – La funzione di blocco non è disponibile quando la lavagna è in modalità T.120.
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▼ Salvare il contenuto della lavagna in un file

● Scegliere File ➤ Apri.

oppure

● Scegliere File ➤ Salva, oppure File ➤ Salva con nome.

▼ Stampare il contenuto della lavagna

● Fare clic sul pulsante di stampa, oppure scegliere File ➤ Stampa.

FIGURA 2-11 Pulsante Stampa

Nella finestra di stampa, specificare la stampante o il nome del file di destinazione e le

pagine che si desidera stampare.

Nota – Il nome della stampante deve essere un dispositivo di stampa valido.

Il software SunForum permette anche di specificare una stampante di rete.
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CAPITOLO 3

Telefono di SunForum

Nel presente capitolo verranno trattati gli argomenti seguenti:

■ “Avvio del telefono di SunForum” a pagina 37

■ “Menu del telefono di SunForum” a pagina 39

■ “Uso del telefono di SunForum” a pagina 41

■ “Video personale” a pagina 43

■ “Impostazione dei dispositivi audio e video” a pagina 44

■ “Procedura guidata per la configurazione del telefono” a pagina 45

■ “Preferenze” a pagina 46.

Avvio del telefono di SunForum

● Dopo avere installato i pacchetti del software SunForum 3.2, digitare il comando
seguente al prompt di sistema:

Nota – Se la directory SunForum non è impostata nel proprio percorso, digitare il

nome di percorso corretto (ad esempio, /opt/SUNWdat/bin/phone ).

Viene visualizzata l’interfaccia telefono di SunForum (FIGURA 3-1).

% phone
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FIGURA 3-1 Telefono di SunForum

Nota – Quando il telefono di SunForum è visualizzato, è possibile passare al gestore

di conferenze dal menu Controls dell’interfaccia telefono. Non è possibile, tuttavia,

avviare il telefono dal gestore di conferenze, qualora si avvii prima SunForum.

Nota – L’interfaccia telefono di SunForum viene utilizzata per le chiamate audio e

video. Per le modalità di collaborazione o le impostazioni avanzate, è necessario

passare al gestore di conferenze di SunForum (vedere il Capitolo 2 “Uso di

SunForum”).

Campo di

Tastiera del telefono

Pulsante Chiama

Pulsante Interrompi

Pulsante Cancella

Indicatore volume

Microfono telefono

Pulsante Volume

Pulsanti di controllo del volume

Campo nome

Pulsante Video personale

modifica chiamata
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Menu del telefono di SunForum

La barra dei menu del telefono di SunForum comprende quattro menu: Call,

Controls, Address Book e Help. Le tabelle seguenti descrivono le singole opzioni dei

menu del telefono.

Menu Call

Nota – La voce di menu Place Call e il pulsante Chiama sul telefono rimangono

disabilitati finché non si inserisce un indirizzo nel campo di modifica chiamata

(FIGURA 3-1).

TABELLA 3-1 Menu Call

Voce di menu Descrizione

Place Call Effettua una chiamata all'indirizzo indicato. In alternativa, è

possibile fare clic sul pulsante Chiama.

Hang Up Termina la chiamata (equivale a fare clic sul pulsante Interrompi).

Change My Information Consente di modificare le informazioni del proprio profilo

SunForum.

Directory Visualizza il server di elenchi. Riporta la lista degli utenti con i

quali è possibile avviare una conferenza.

Lista di numeri di telefono Lista cronologica degli ultimi numeri composti (elenca un

massimo di 10 numeri di telefono)

Exit Esce dal telefono di SunForum.
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Menu Controls

Menu Address Book

Il menu Address Book del telefono di SunForum elenca la rubrica dell’utente e gli

indirizzi non utilizzati di frequente. La parte cronologica del menu Call contiene,

tuttavia, un elenco degli ultimi 10 indirizzi utilizzati.

Nelle finestre Add Address e New Address, l’utente può creare tre diversi tipi di

indirizzi:

■ Telephone: un numero di telefono da utilizzare con un gateway.

■ Network (TCP/IP): un alias di chiamata da utilizzare con un gatekeeper Sun.

■ Directory: un elenco LDAP da utilizzare con l’indirizzo.

TABELLA 3-2 Menu Controls

Voce di menu Descrizione

Volume Consente di aumentare, diminuire o azzerare il volume.

Microphone Accende e spegne il microfono.

Toggle SunForum Apre e chiude il gestore di conferenze di SunForum.

Audio/Video Device

Settings

Permette di selezionare i dispositivi audio e video e di configurarne

le impostazioni.

Media Config

Wizard

Procedura guidata che facilita la configurazione delle impostazioni

dei dispositivi audio e video.

Preferences Permette di impostare le preferenze relative a chiamate in arrivo,

tasto del telefono e cursore.

TABELLA 3-3 Menu Address Book

Voce di menu Descrizione

Add Address Consente di aggiungere un indirizzo alla rubrica (Address Book).

Quest’opzione è disponibile solo quando si seleziona un

partecipante alla conferenza nell’elenco del telefono. Le informazioni

sull’indirizzo vengono automaticamente compilate dal sistema.

New Address Consente di aggiungere un nuovo indirizzo. Quest’opzione è sempre

disponibile.

Edit Address Book Visualizza una lista di indirizzi nella rubrica e consente di creare,

modificare o eliminare degli indirizzi.

Lista di indirizzi Lista di indirizzi con i quali si effettuano di frequente conferenze.
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Menu Help

Il menu Help del telefono di SunForum permette di accedere alle informazioni della

guida in linea.

● Scegliere Help ➤ Phone Help per visualizzare informazioni sul telefono di
SunForum;

oppure

● Scegliere Help ➤ Popup Help.

L’opzione Popup Help attiva la visualizzazione dei messaggi della guida che

appaiono sotto il cursore quando quest’ultimo viene posizionato su molti dei

controlli dell’interfaccia telefono.

Uso del telefono di SunForum

Dopo avere visualizzato il telefono di SunForum e avere configurato le impostazioni

per i dispositivi audio e video, nonché le preferenze relative al telefono (TABELLA 3-1

e TABELLA 3-2), si è pronti per eseguire una chiamata.

Eseguire una chiamata

Per eseguire una chiamata, oltre alla barra dei menu del telefono è possibile

utilizzare l’interfaccia telefono.

▼ Eseguire una chiamata tramite l’interfaccia telefono

● Comporre il numero di telefono che si desidera chiamare facendo clic sui numeri
della tastiera dell’interfaccia telefono.

Il numero viene visualizzato nel campo appena sopra la tastiera. Quindi fare clic

sull’icona Chiama per eseguire la chiamata (FIGURA 3-2).

Oppure

● Digitare il numero di telefono, o il nome alias, dalla tastiera del computer.

Il numero viene visualizzato nel campo appena sopra la tastiera. Premere Return

sulla tastiera (oppure fare clic sull’icona Chiama) per eseguire la chiamata.
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Dopo avere impostato la chiamata, mentre il sistema compone il numero viene

visualizzata la finestra Outgoing Call, dalla quale è inoltre possibile annullare la

chiamata.

FIGURA 3-2 Eseguire una chiamata

▼ Cancellare un numero immesso

● Cancellare il numero dalla tastiera del computer, selezionando l’intero campo di
modifica chiamata e premendo quindi il tasto Delete.

oppure

● Fare clic sul pulsante Cancella finché il numero non viene completamente
cancellato.

▼ Accendere il microfono del telefono

● Fare clic sul pulsante Microfono telefono.

Nota – Si raccomanda di utilizzare un microfono per telefono o una cuffia dotata di

microfono per ciascun partecipante alla conferenza.

Campo di

Tastiera del telefono

Pulsante Chiama

Pulsante Interrompi

Pulsante Cancella

Indicatore volume

Microfono telefono

Pulsante Volume

Pulsanti di controllo del volume

Campo nome

Pulsante Video personale

modifica chiamata
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Video personale

È possibile visualizzare il video personale trasmesso durante una conferenza e

configurare le impostazioni audio e video. Per procedere:

1. Fare doppio clic sul pulsante Video personale (FIGURA 3-2) accanto al proprio nome
nel campo Nome. Vedere la FIGURA 3-2.

Viene visualizzata la finestra My Video (Video personale).

2. Dalla barra dei menu della finestra My Video, scegliere View ➤ Audio/Video
Settings.

Viene visualizzata la finestra Audio/Video Settings. La TABELLA 3-4 descrive le

diverse opzioni di impostazione.

TABELLA 3-4 Impostazioni audio e video

Voce di menu Descrizione

Use point-to-point

Audio/Video

connections

Questa opzione consente di utilizzare soltanto connessioni punto-punto

per le conferenze audio/video. In tal modo, gli utenti dotati soltanto di

capacità punto-punto possono utilizzare l'audio e il video come parte della

conferenza.

Send image size Specifica le dimensioni dell'immagine video nel modo in cui appare agli

altri partecipanti. Questa opzione determina inoltre le dimensioni della

finestra My Video (Video personale). La gamma di dimensioni di finestra

che è possibile usare dipende dalle capacità dei prodotti di conferencing

impiegati dagli altri partecipanti. Se è già in corso una conferenza,

è possibile che una o più di queste opzioni siano inattive se gli altri

partecipanti impiegano prodotti di conferencing che non le supportano.

Può accadere che le dimensioni della finestra vengano modificate all'inizio

di una chiamata o nel momento in cui un altro partecipante interviene o

abbandona la conferenza. Ciò è dovuto al fatto che alcuni dei partecipanti

potrebbero non essere in grado di utilizzare le dimensioni inizialmente

selezionate; SunForum interagisce con gli altri prodotti di conferencing

in modo da selezionare il compromesso migliore tra i requisiti dei

partecipanti alla conferenza.

Default video

magnification

Specifica la percentuale di ingrandimento predefinita (100% - 400%) per la

visualizzazione video sul sistema.
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Impostazione dei dispositivi audio e
video

▼ Per impostare le opzioni dei dispositivi audio/video

● Scegliere Controls ➤ Audio/Video Device Settings dalla barra dei menu del telefono.

I prefer to

receive...

Questa opzione consente di impostare in dettaglio la qualità

dell'immagine video di altri utenti appena questi appaiono sullo schermo.

- Spostare la casella di scorrimento verso Video più rapido per

visualizzare il video con aggiornamenti più frequenti al secondo. In tal

modo, si ottiene una visualizzazione più continua, ma si riduce la

risoluzione dell'immagine.

- Spostare la casella di scorrimento verso Qualità migliore per

visualizzare il video con una risoluzione più alta. In tal modo, si

ottiene un'immagine video di qualità migliore, ma la visualizzazione

risulta meno continua

Connection speed Selezionare l'opzione che corrisponde alla rete su cui si utilizza SunForum 3.2.

Echo suppression Selezionando questa opzione, SunForum 3.2 disattiva il microfono durante

la riproduzione audio (half-duplex).

Auto Gain Control Selezionando questa opzione, SunForum 3.2 regola automaticamente la

sensibilità del microfono basandosi sul livello di ingresso.

TABELLA 3-5 Opzioni dei dispositivi audio e video

Voce di menu Descrizione

Audio Device Consente di scegliere il dispositivo audio da usare durante la conferenza e

gli attributi associati a tale dispositivo. Occorre prima selezionare il

dispositivo audio da usare dal menu e quindi premere il pulsante “Settings”

(impostazioni) per configurare gli attributi specifici del dispositivo. Ciascun

dispositivo è un attributo univoco che è possibile configurare.

Video Device Consente di scegliere il dispositivo video da usare durante la conferenza e

gli attributi associati a tale dispositivo. L'opzione “None” (nessuno)

riguarda i sistemi privi di capacità di cattura video o impostati in modo da

disattivarle. Occorre prima selezionare il dispositivo video da usare dal

menu e quindi premere il pulsante “Settings” per configurare gli attributi

specifici del dispositivo. Ciascun dispositivo è un attributo univoco che è

possibile configurare.

TABELLA 3-4 Impostazioni audio e video (Continua)

Voce di menu Descrizione
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Procedura guidata per la configurazione
del telefono

La procedura di guidata per la configurazione del telefono di SunForum facilita

l’impostazione delle opzioni audio e video. La TABELLA 3-6 descrive le impostazioni

e i test dei dispositivi eseguiti tramite la procedura guidata.

1. Scegliere Controls ➤ Media Configuration Wizard dalla barra dei menu del telefono.

Accertarsi di chiudere tutte le altre applicazioni che utilizzano funzioni audio e video.

2. Fare clic su Next in ciascuna finestra per passare da una pagina all’altra della
procedura di configurazione (TABELLA 3-6).

3. Al termine, fare clic su Finish nell’ultima pagina.

Nota – Durante una chiamata, il Media Configuration Wizard non è disponibile.

TABELLA 3-6 Procedura guidata di configurazione

Voce di menu Descrizione

Media Device

Setting

Consente di scegliere il dispositivo audio da usare durante la conferenza e

gli attributi associati a tale dispositivo. Occorre prima selezionare il

dispositivo audio da usare dal menu e quindi premere il pulsante “Settings”

(impostazioni) per configurare gli attributi specifici del dispositivo. Ciascun

dispositivo è un attributo univoco che è possibile configurare.

Audio Output Consente di controllare il corretto funzionamento degli altoparlanti e delle

cuffie. Fare clic sul pulsante Test per eseguire un audio di prova e regolare

il volume spostando la relativa casella di scorrimento.

Microphone

Level

Consente di controllare il corretto funzionamento del microfono e di

regolarlo automaticamente a un livello accettabile.
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Preferenze

La finestra Preferences del telefono di SunForum (FIGURA 3-3) consente di configurare

le chiamate in arrivo, il tasto del telefono e l’azione del cursore. La TABELLA 3-7

descrive le opzioni della finestra per la configurazione delle preferenze.

FIGURA 3-3 Finestra Preferences del telefono di SunForum

● Scegliere Controls ➤ Preferences dalla barra dei menu del telefono.

TABELLA 3-7 Preferenze del telefono di SunForum

Voce di menu Descrizione

Incoming

Calls

Consente di impostare il tipo di squillo per le chiamate in arrivo, di

impostare uno squillo continuo o un determinato numero di squilli, di

impostare l’intervallo tra gli squilli in secondi e di impostare lo squillo

attraverso l’altoparlante a disposizione. Selezionando l’opzione Ring

Through Speaker la suoneria viene forzatamente eseguita dall’altoparlante

esterno in caso di chiamate in arrivo, il che permette all’utente di sentire gli

squilli anche se non indossa le cuffie.

Telephone

Key

Consente di assegnare un tasto da utilizzare per rispondere alle chiamate in

arrivo. È possibile selezionare i tasti Control, Alt e Meta come tasti funzione

(ad esempio, Alt-F5).

Cursor Consente di impostare l’azione del cursore in un campo di indirizzo di chiamata.

Le opzioni disponibili sono: lampeggiante, fermo o nessuna azione.
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CAPITOLO 4

Configurazione del software gateway

Questo capitolo descrive come configurare il software gateway per eseguire

chiamate tramite la rete utilizzando il telefono di SunForum.

Panoramica

Il software gateway consente di connettersi a un server designato che fornisce le

linee telefoniche richieste per effettuare telefonate tramite una rete utilizzando il

telefono di SunForum (vedere il Capitolo 3 “Telefono di SunForum”). Dopo avere

aggiornato il file di configurazione del gateway, è possibile chiamare le linee

telefoniche del server gateway che collegano le proprie chiamate in rete.

File di configurazione del gateway
Per aggiornare il file di configurazione del gateway:

1. Accedere come superutente ad una finestra shell.

2. Passare alla directory di configurazione di SunForum:

3. Aprire il file di configurazione di sistema di SunForum:

# cd /opt/SUNWdat/config

# vi system-config
47



4. Trovare la parte del file di configurazione relativa alle impostazioni del gateway e
digitare le informazioni richieste.

In questo esempio, il nome del server designato come server gateway è Server 1 e

011# è il prefisso del gateway che potrebbe essere richiesto per eseguire la chiamata

a un server gateway.

5. Salvare il file, uscire dal profilo di superutente e avviare il telefono di SunForum
(vedere il Capitolo 3 “Telefono di SunForum”).

Il menu Controls del telefono di SunForum ora elenca l’opzione Gateway Mode.

6. Attivare Gateway Mode dal menu Controls.

Lo schermo del telefono di SunForum passa in modalità gateway (FIGURA 4-1).

FIGURA 4-1 Telefono di SunForum in modalità Gateway PBX

!
! Gateway settings
!
H323.CallViaGateway:  TRUE
H323.GatewayName:  server1
H323.GatewayPrefix:  011#
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Uso del gateway del telefono di
SunForum

La FIGURA 4-2 riporta un esempio di un sistema in rete che accede a un server

gateway. Questo esempio mostra delle workstation Sun Ultra e dei sistemi Sun Ray

collegati alla rete. Per ulteriori informazioni su SunForum e i sistemi Sun Ray, vedere

il Capitolo 5 “SunForum su un sistema Sun Ray”. I sistemi Sun Ray necessitano del

software gatekeeper Sun per poter eseguire chiamate tramite una WAN (Wide Area

Network).

FIGURA 4-2 Esempio di rete gateway di sistemi che eseguono SunForum 3.2

In questo esempio, le workstation Sun e i sistemi Sun Ray eseguono SunForum 3.2

e SunForum Phone (il telefono di SunForum). Server 1 è un server gateway a due

linee e indica le linee telefoniche richieste per effettuare le telefonate verso telefoni.

Per poter eseguire una telefonata tramite la rete dal telefono di SunForum,

è necessario prima chiamare e connettersi al server gateway designato. I sistemi

Sun Ray, come mostrato, passano attraverso il server Sun Ray e il gatekeeper Sun

per eseguire una chiamata tramite la rete. Vedere “Software gatekeeper Sun” a

pagina 52.

LAN

Sun Ray

Ultra 10

Server 1

Ultra 10

Ultra 80

Server

Server Sun Ray con
gatekeeper Sun

Server

Linea telef. 011#
Linea telef. 022#Sun Ray

PBX o
società
telefonica

gateway
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Per eseguire una chiamata in rete con il telefono di SunForum:

1. Avviare il telefono di SunForum.

2. Aggiornare il file di configurazione di sistema.

Vedere “File di configurazione del gateway” a pagina 47.

3. Scegliere Controls ➤ Gateway Mode.

Il telefono di SunForum visualizza le modifiche alla modalità gateway.

FIGURA 4-3 Modalità gateway

4. Nel campo di modifica chiamata (FIGURA 4-3), immettere il numero che si desidera
chiamare.

5. Premere Return o fare clic sul pulsante Chiama, per ottenere la connessione.

Nota – Si tratta di una procedura analoga alla chiamata diretta del gateway

utilizzando l’estensione 011# al tono di chiamata, quando si compone il numero di

telefono (in questo esempio, 46953) utilizzando DTMF.

Campo di
modifica
chiamata
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CAPITOLO 5

SunForum su un sistema Sun Ray

Nel presente capitolo verranno trattati gli argomenti seguenti:

■ “Requisiti del sistema Sun Ray” a pagina 51

■ “Software gatekeeper Sun” a pagina 52.

Requisiti del sistema Sun Ray

Per il supporto di SunForum 3.2, è necessario che il sistema Sun disponga del

software Sun Ray Server 1.2. Per la procedura di installazione di questo software,

consultare la documentazione fornita con il sistema Sun Ray.

Se sono disponibili patch del software Sun Ray 1.2 per SunForum, installare le patch

invece di eseguire la procedura descritta nella sezione seguente “Librerie Sun Ray”.

Librerie Sun Ray

Nota – Seguire le istruzioni sotto riportate solo quando si aggiunge il supporto

SunForum al software Sun Ray Server 1.2.

Per installazioni che utilizzano client Sun Ray sono richieste due librerie Sun Ray:

libutmedia.so e libutadmin.so .

Per installare queste librerie:

● Copiare entrambe le librerie dalla directory supplementare del CD-ROM nella
directory delle librerie di Sun Ray /opt/SUNWut/lib/ .
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Software gatekeeper Sun

Panoramica

SunForum 3.2 include un gatekeeper H.323 richiesto quando si utilizza SunForum

con un sistema Sun Ray. Dopo avere installato il pacchetto SUNWkeep, l’opzione

gatekeeper risulta disponibile. Il pacchetto SUNWkeepviene installato con il software

SunForum 3.2 (vedere il Manuale di installazione di SunForum 3.2).

Un gatekeeper è un software utilizzato per il controllo delle chiamate e per la gestione

delle reti per la trasmissione di voce, video e dati. Dopo avere installato e avviato il

gatekeeper, gli utenti H.323 (inclusi gli utenti di SunForum) provvedono a

registrarsi. A tale scopo vengono utilizzati gli indirizzi IP, assieme agli alias H.323

(nomi e numeri); tutte le chiamate vengono quindi instradate tramite questa

posizione centrale.

Oltre ad essere richiesto per l’uso di SunForum su sistemi Sun Ray, il software

gatekeeper è necessario anche in un ambiente di conferencing tra workstation Sun,

nel caso in cui almeno un sistema Sun Ray desideri entrare a fare parte di questo

ambiente di workstation.

Il gatekeeper Sun fornito con SunForum 3.2 offre soltanto le funzioni di traduzione

degli indirizzi e di aliasing per i numeri di porta. Per questo motivo, il daemon

viene chiamato “registrar” (il gatekeeper Sun non supporta la gestione

dell’ampiezza di banda).

Il gatekeeper richiede che a ciascun utente registrato corrispondano uno o più alias

univoci. Si consiglia di fare in modo che ciascun client SunForum utilizzi un numero

di interno, un indirizzo di e-mail o un altro nome univoco.
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Avvio del gatekeeper Sun

Nota – In qualsiasi installazione, è possibile eseguire un solo gatekeeper. È possibile

installare il pacchetto in più posizioni, tuttavia solo un server può avviare il daemon

gatekeeper.

1. Decidere su quale server avviare il software gatekeeper.

2. Accedere come superutente.

3. Avviare il gatekeeper Sun. Digitare:

Nota – Se la directory di SunForum non è impostata nel proprio percorso, digitare il

nome di percorso corretto (ad esempio, /opt/SUNWkeep/bin/registrar start ).

Modifica del file di configurazione di sistema

Per impostazione predefinita, i client SunForum 3.2 eseguono un rilevamento

automatico del server gatekeeper. Questo rilevamento automatico utilizza IP

Multicast e potrebbe non riuscire ad accedere attraverso i router che passano in

sottoreti. In questo caso, è necessario specificare il gatekeeper per nome. Per

specificare il server gatekeeper, occorre modificare il file di configurazione:

1. Accedere al sistema come superutente.

2. Passare al file di configurazione di sistema:

# registrar start

# cd /opt/SUNWdat/config/
# vi system-config
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3. Cambiare le impostazioni predefinite del file di configurazione.

L’esempio seguente utilizza “GK-server” come nome server selezionato.

Nota – Qualora un gatekeeper risulti non più disponibile (a causa di un guasto

del sistema o della rete), non sarà possibile rispondere alle chiamate in arrivo.

Si raccomanda di selezionare come server gatekeeper un sistema affidabile su

una sottorete altrettanto affidabile.

4. Per visualizzare gli utenti registrati presso il gatekeeper, digitare:

Default setting: for auto discovery
H323.GKDiscovery: 1
H323.GKName: None

Change to: for manual gatekeeper specification
H323.GKDiscover: 2
H323.GKName: GK-server

% registrar -q
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CAPITOLO 6

Informazioni tecniche

Nel presente capitolo verranno trattati gli argomenti seguenti:

■ “Architettura di SunForum” a pagina 55

■ “Topologia per le conferenze di SunForum” a pagina 56

■ “Lavagna di SunForum e modalità di compatibilità” a pagina 57

■ “Uso del software SunForum con un meccanismo di sicurezza della rete” a

pagina 58

■ “Uso di font TrueType con SunForum” a pagina 59

■ “Chiamata a un’unità di conferenze multipunto” a pagina 59

■ “Conferenze protette da password” a pagina 60

■ “Risoluzione dei problemi con i colori” a pagina 60

■ “Supporto del software SunForum” a pagina 61.

Architettura di SunForum

L’architettura di SunForum è basata sullo standard ITU (International

Telecommunications Union) H.323, che definisce una serie di protocolli per la

comunicazione multimediale e attività di conferencing tramite rete basate su

pacchetti. L’architettura H.323 include i principi di base per le comunicazioni audio

(standard G.7xx), video (standard H.26x) e di dati (famiglia di standard T.120).

Lo standard T.120 contiene una serie di servizi e protocolli di comunicazione e

applicativi per il supporto delle comunicazioni di dati multipoint in tempo reale.

La famiglia G.7xx contiene gli standard G.711, G.723 e G.729 per la comunicazione audio.

La famiglia H.26x contiene gli standard H.261 e H.263 per la compressione video.
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L’architettura T.120 è strutturata a più livelli con protocolli e servizi definiti per ogni

livello. I livelli superiori dell’architettura richiedono, per operare, i livelli di grado

inferiore.

I livelli inferiori (da T.122 a T.125) specificano un meccanismo indipendente

dall’applicazione per la fornitura di servizi di comunicazione multipunto a

qualunque applicazione che possa utilizzarli.

I livelli superiori definiscono protocolli per specifiche applicazioni di conferencing,

come il T.127 per il trasferimento di file multipoint e il T.128 per la condivisione delle

applicazioni.

Le applicazioni che utilizzano questi protocolli standard possono coesistere nella stessa

conferenza con applicazioni che utilizzano protocolli proprietari. Questo significa che

gli utenti di SunForum possono usare un mix di protocolli standard e non standard.

Topologia per le conferenze di
SunForum

Nelle conferenze eseguite con SunForum, la topologia e la gerarchia delle

connessioni è conforme alle topologie per le conferenze H.323 e le conferenze T.120.

In una conferenza H.323 multipunto, ad un’estremità è situato il Multipoint

Controller e tutte le altre terminazioni presentano una singola connessione diretta

con quel Multipoint Controller. In una conferenza H.323 punto-punto, non esiste

alcun Multipoint Controller e le due terminazioni sono semplicemente collegate

mediante una connessione diretta. Nelle conferenze T.120, la topologia è più

complessa e influenza il comportamento delle connessioni. Tale circostanza viene

descritta in maggiore dettaglio nel seguito.

In una conferenza T.120, esiste una gerarchia in cui la persona che ha avviato la

conferenza si trova a un livello più alto e gli altri partecipanti sono a un livello

inferiore. La posizione di un chiamante in questa topologia influisce sullo stato della

connessione degli utenti che sono entrati a far parte della conferenza tramite quel

chiamante. Questa situazione viene illustrata nella figura seguente.

In questo esempio,

■ Se B interrompe il collegamento, vengono disconnessi anche tutti gli utenti che

erano stati chiamati da B, mentre A e D rimangono in conferenza.

■ Se D interrompe il collegamento, non viene disconnesso nessun altro utente; A, B

e C rimangono in conferenza.

■ Se A interrompe il collegamento, l'intera conferenza viene terminata.
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FIGURA 6-1 Gerarchia delle conferenze T.120

Per creare una conferenza si designa un sistema, l'host della conferenza, che dovrà

essere chiamato dai partecipanti. Viene così creata una topologia a stella (come nei

protocolli di rete a stella) in cui qualunque utente, escluso l'host, può abbandonare la

conferenza in modo indipendente. (L'host può anche essere un server di conferenze
dedicato, in grado di supportare diverse conferenze simultaneamente).

Lavagna di SunForum e modalità di
compatibilità
La lavagna di SunForum può essere impostata in diverse modalità:

■ Modalità SunForum 1.0, che consente di interoperare con alcuni software di

collaborazione in esecuzione su PC. Per scegliere questa modalità, fare clic sul menu

Opzioni ➤ Impostazioni strumenti, quindi scegliere la modalità SunForum 1.0.

■ Modalità “True T.126”, che consente di interoperare con qualsiasi sistema o

apparecchiatura che utilizza il protocollo T.126, indipendentemente dal software

della piattaforma. Per scegliere questa modalità, fare clic sul menu Opzioni ➤

Impostazioni strumenti, quindi scegliere la modalità T.126 e i pulsanti T.120.

■ Modalità “NetMeeting 3.x style T.126”, che consente di interoperare con la

lavagna di NetMeeting 3.x. Per scegliere questa modalità, fare clic sul menu

Opzioni ➤ Impostazioni strumenti, quindi scegliere la modalità T.126 e i pulsanti

NetMeeting 3.

Chiamante A

Chiamante B

Chiamante A Chiamante A

Chiamante C

Chiamante B Chiamante B

Chiamante C

A chiama B B chiama C (o C chiama B) A chiama D (o D chiama A)

A inizia la conferenza
con B

C si unisce alla conferenza D si unisce alla conferenza
tramite Atramite B

Chiamante D
Informazioni tecniche 57



La scelta della modalità di compatibilità eseguita in Opzioni ➤ Impostazioni strumenti

influenza anche altre aree di SunForum. La differenza più evidente tra le due modalità

è nella funzione di condivisione applicazioni.

■ La modalità T.120 è stata progettata per garantire la conformità con lo standard

T.120 e in questa modalità SunForum dovrebbe essere in grado di interoperare

con altri sistemi che utilizzano lo stack del protocollo T.120. Per interoperare con

sistemi NetMeeting 2.x, utilizzare questa modalità.

■ La modalità NetMeeting 3 consente di interoperare con alcuni software di

collaborazione in esecuzione su PC (in particolare, NetMeeting 3.x) e rende la

funzione di condivisione delle applicazioni simile a quella di NetMeeting 3.01.

Per selezionare la modalità di compatibilità, scegliere Opzioni ➤ Impostazioni

strumenti.

Uso del software SunForum con un
meccanismo di sicurezza della rete
Se si è collegati a Internet attraverso un meccanismo di sicurezza della rete,

tipicamente un firewall (come nella maggior parte degli ambienti LAN/aziendali), è

possibile usare il software SunForum per comunicare con altre persone che si trovino

sia all'interno che all'esterno del firewall.

Affinché sia possibile avere una comunicazione completa verso l’esterno, il firewall

(cioè il meccanismo di sicurezza della rete) deve essere impostato in modo da

consentire la comunicazione attraverso determinate porte (in altre parole, è

necessario che le porte vengano “aperte”):

■ Verificare che il gateway predefinito della workstation sia impostato sull'indirizzo

interno del computer con il meccanismo di sicurezza della rete.

■ Configurare il meccanismo di sicurezza della rete in modo da consentire i

collegamenti TCP primari attraverso le seguenti porte IP:

■ 389 - per le comunicazioni con sistemi ILS (Internet Locator Server)

■ 1503 - per i dati T.120, cioè per condivisione applicazioni, trasferimento file,

lavagna e conversazione

■ 1718 (UDP) - per il rilevamento dei gatekeeper H.323 (richiesto solo se si

utilizza la funzione di rilevamento automatico gatekeeper)

■ 1719 (UDP) - per la comunicazione con gatekeeper H.323

■ (TCP) - per l’impostazione delle chiamate H.323.
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■ Assicurare che il firewall sia configurato in modo da consentire l’uso di porte IP

dinamiche (porte TCP per la gestione chiamate H.323 e porte UDP per i flussi

audio e video). A tale fine, potrebbe essere necessario utilizzare un firewall

speciale con funzionalità H.323.

■ Configurare il firewall in modo da mappare gli indirizzi IP interni con gli

indirizzi Internet esterni. Non tutti i meccanismi di sicurezza della rete offrono

questa possibilità. Se questa configurazione non è possibile, si potrà chiamare

all'esterno dall'interno della rete protetta, ma non si potranno ricevere le chiamate

in arrivo provenienti da sistemi al di fuori del firewall.

Se non si è certi sull'uso di un meccanismo di sicurezza della rete per l'accesso a

Internet, rivolgersi all'amministratore di sistema o al provider di servizi Internet.

Uso di font TrueType con SunForum

Se sul sistema è installato un server di font TrueType (o tale server è accessibile nella

rete locale), il software SunForum permette di utilizzarlo. Solaris 2.6 e versioni

successive supportano i font TrueType.

Con un server di font TrueType, il software SunForum ha a disposizione un maggior

numero di font in comune con i PC, permettendo un output di migliore qualità e

prestazioni migliori nelle sessioni condivise tra sistemi UNIX e PC.

Chiamata a un’unità di conferenze
multipunto

Il software SunForum supporta le conferenze con host MCU (Multipoint Control

Unit) ed è stato testato con alcuni dei sistemi MCU disponibili al momento

dell’uscita di questa release.

Per chiamare un MCU, è sufficiente specificare normalmente l'indirizzo dell'MCU.

Se il software SunForum rileva che il sistema chiamato sta fungendo da host per più di

una conferenza, verrà chiesto di specificare a quale conferenza si desidera partecipare.

Vedere anche “Conferenze protette da password”.
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Conferenze protette da password

SunForum non permette di creare conferenze protette da password.

Quando si accede a una conferenza che è stata creata con la protezione di una

password, il software SunForum chiede di specificare la password.

Alcune implementazioni T.120 dichiarano erroneamente che le conferenze sono

protette da una password anche quando non è stata specificata alcuna password.

In questo caso, fare clic semplicemente su OK senza specificare la password; la

conferenza verrà stabilita normalmente.

Ottimizzazione della visualizzazione

Per ottenere prestazioni video superiori, aumentare le dimensioni della memoria

condivisa di almeno 16 MB, procedendo come segue:

1. Aggiungere la riga seguente al file /etc/system :

2. Riavviare il sistema.

Risoluzione dei problemi con i colori

Se si incontrano problemi con l'uso dei colori (ad esempio, per l'evidenziazione di un

testo) nelle applicazioni per PC condivise, provare la seguente procedura:

■ Se il server X è in esecuzione con la visualizzazione predefinita Static o DirectColor,

impostare la visualizzazione PseudoColor o GrayScale. Per informazioni sulla

procedura, vedere la documentazione del server X.

■ Chiudere le applicazioni X locali che fanno un uso intenso del colore (come gli

editor bitmap e i Web browser) per rendere disponibile un maggior numero di

colori per il software SunForum.

set shmsys:shminfo_shmmax=16777216
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Supporto del software SunForum

Se si incontrano problemi nell'installazione o nell'uso del software SunForum:

■ Consultare la documentazione stampata o in linea fornita con il software.

■ Per una descrizione dei problemi noti di questa release, leggere le altre sezioni

della guida in linea, in particolare la pagina LEGGIMI.

■ Se non si riesce a trovare una soluzione al proprio problema, contattare la filiale

locale Sun preparandosi a fornire le seguenti informazioni:

■ Configurazione del sistema (hardware, versione del sistema operativo, scheda

grafica)

■ Una descrizione completa delle operazioni che si stavano eseguendo quando si

è verificato il problema

■ I file core eventualmente generati (nella directory /opt/SUNWdat )

■ Il contenuto dei file di log eventualmente generati (cercare nomehost.trc1 e

nomehost.trc2 , nella directory $HOME/.sunforum/trc ).
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